HOW TO PRINT FROM 365

Printing from 365 online versions of Word, Excel and Powerpoint is slightly different from printing from the desktop
versions of these programs. Not all the same options that are present in the desktop versions exist in the online

apps. Here are the differences between them:

I. Word 365 vs Word desktop

Word online:

Note: What you see displayed in the normal view differs from the Reading view and how the document will be
printed in the online version of Word as oppose to the desktop one. Word online print:

tH] 1 ﬂ document with tables @

Home nsert Layout Refi

Ifb Autosaved online to Attachments

There are 2 ways to access the print dialogue:
1. Click on "File", then click on "Print", the document is then
converted to pdf (a pop-up is briefly displayed)

= Open > or
[ Share >
O Create a Copy > ) T ) "
| 5 Bpon ; If you are in a "Viewing Mode
2. From the reading view click on "Print" button.
Click on "Open PDF" to open the Print dialogue.
D Rename
Fg Move File

5) Version History

@ Info >
u document with tables (@)
Print ?
Total: 3 sheets of paper
Paper size
_1 Microsoft Print to PDF ~ A4 w
Copies Scale (%)
2]
=) 1 o Fit to printable area
Layout ( ) Actual size
~—J o Portrait ( ) 55
@) Landscape
) Pages per sheet
4J Pages 1 ~
O
Print using system dialogue... (Ctrl+Shift+P)
( ) Odd pages only
( ) Even pages only
eg. 1-5 8, 11-13
5J Colour
- Colour “, Colour
Colour
6J More settings
e Black and white
Print using system dialogue.., (Ctrl+Shift+P)

“ Ca nce'
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\ Microsoft Word *

All done. Your file is ready to print.

Close

: & (5)
8 et Mode 7 Et Dot < .3

The print window has the following options:
1. Select a printer
2. Number of copies
3. Layout (Portrait or Landscape)
4. Pages (all / odd or even / page numbers)
5. Colour (colour/B&W)
6. More settings:

* Paper size

* Scale (Fit to printable area / Actual size /

Percentage)
* Pages per sheet
* Print using system dialogue window
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Things to check and or change before printing that can help the document “fit” better on the page:

File Home Insert | Layoull Refere

Under "Layout":

Office 2003 Default
Bottom: 1"
1.25"

Top: 1"
Left: 1.25" Right:

Custom Margins
Define custom margins

1Al

Desktop Word version:

Insert Design Layout References Mailings

Insert Layout | Layoull References  Review  View  Help

1. Margins (select the type that
suits the document content
best or choose "Custom
Margins" to select your own)
2. Orientation (toggling
between Portrait and

Orientation sometimes helps to
position the content better on

the page)

Custom Page Size
Define custom pag

'1 (0 Margins ~ [ Orientation v~ [[§ '2 [ Orientation v ntaﬂ v [E~v 12~ | 3= IndentLeft
Portrait
Normil . D Letter
Top: 1 Bottom: 1 7 Land 85" % 11"
Left 1" Right 1 \—__20cene ) '
— Narrow Legal
Top: 0.5" Bottom: 0.5" 85" % 14"
g Left: 0.5" Right: 0.5"
Executive
Moderate |:| B .
E Top: 1" Bottom: 1" 7.25" x 10.5
Left: 0.75" Right:  0.75"
A4
Wide 8.27" x 11.69"
Top: 1" Bottom: 1"
Left: 2" Right: 2"
] %
E 583" x8.27"

3. Paper size (it is very
important to ensure you always
select "A4" as the size)

e size

J

™ [Z] Outline j\ $|:| EE [¥] Ruler
| !_\
2 S ot U R €3 1 Grdines BE Multig
Learning Vertical Side Zoom 100%
Tools to Side O MNavigation Pane & Page
Views Immersive  Page Movement Show Zoom
o
—
[ L) E e
1y
| 7 [ Line Nu
= Breaks - 2 Size  Columns

iD Line Mumbers ~

hc Hyphenation -

[]

i
[

Letter

Tabloid

Legal

Statement

13.97 cmx 21,59 cm

Executive

1841 emx 26.67 cm

A3

]

b Hyphena
2158 cmx 27.94 cm
2784 cmx 4318 cm

21.59 cmx 35.56 cm

297 emx 42 cm

Ad
21 emx 287 cm

A5

O

B4 (JIS)

257 emx 36.4 cm

B5 (JIS)

182 emx 25.7 cm

More Paper Sizes...
=

148emx 21 cm

a
C

Last Custom Setting

E Top:  1.27cm  Bottorm:1.27%g
Left:  1.27cm  Rightt 1.27crm? g ID
Normal Orientation  Size
Top:  254cm  Bottom:2.34 cm = =
Left: 2534 cm  Rightt 2534 cm

D Portrait

— Narrow
Top:  1.27cm  Bottom:1.27 cm
Leftt  127cm  Right 1.27cm = tandscape
Moderate
Top: 2534 cm  Bottom:2.3cm
Left  1.97ecm Right 1.91cm
Wide
Top: 234 cm  Bottom:2.34 cm
Left:  5.08ecm Right: 5.08cm
Mirrored

m Top: 254 cm  Bottom: 2,534 cm
Inside: 318 cm  Outside:2.54 cm

Custom Margins...
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Before printing you can go to

1. View > Print Layout to check how
the content will look when printed.

2. If any adjustments are necessary
go to Layout > and check these:

a) Margins (select from pre-set or
choose your own from Custom
Margins)

b) Orientation (Portrait/Landscape)

c) Size (always ensure it's set to Ad)
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Account
Feedback

Options

Account

Feedback

Options

~
z a==. Microsoft Print to PDF

(W

Pages:
&, E Print One Sided .
Onlyprmtm’lone;ldeofth!!'
5 —  Collated ’
2| E %
S BB 3705 103 »
> 3
D Portrait Orientation B -1
5
=
|:| Ad % .
21emx 297 ecm %
.
&

Frint All Pages .
The whole thing

Printer

=
a Ready
Printer Properties
Settings
B L
Print All Pages I‘

B

The whale thing

Document

o

=

Marrow Margins
Left: 127 cm  Right 1.27. '3

s

35

Document Info

y
\ Only Print Even Pages

Print All Pages
The whole thing

Print Current Page
Just this page

Custom Print
Type specific pages, sections or ranges

Document Info
List of properties, s
List of Markup
Your tracked changes
Styles
List of styles used in your document
AutoText Entries
List of items in your AutoText gallery
Key Assignments
List of your custom shortcut keys

uch as file name, author and title

Print Markup

Only Print Odd Pages

Only print on one side of th...

Print One Sided
Only print on one side of the page

L. Manually Print on Both Sides

Reload paper when prompted to print the second sid

To Print, go to File > Print

The options are:

1. Number of copies to print

2. Printer

3. What pages to print

Note: if you want to print specific pages

typein the "Pages:" field -

will print from page 2 to the last page
1-3  will print pages 1 through 3

2-

1,2,4-6 will print pages 1,2,4,5,6

4. Print on one or both sides

D 1 Page Per Sheet M| %
Page Setup "_
‘IEE 123 123 1,23 I

||=|:||D 123 12,3 123

|—|_ Uncollated
E‘Eq 101 222 333

D Portrait Orientation -

Portrait Orientation

Landscape Orientation J

B
=

1Page Per Sheet

‘..r.

5. Collated (collated/uncollated)

6. Orientation (portrait/landscape)

7. Size (always ensure it's set to Ad)

LT RT TR TTTTTTTTTTTTT ] (o
@ Scale to Paper Size

Vi

8. Margins (select from pre-set or

«
- - -
fm| Copies: |1 . - o - 5
HE# H (’ Last Custom Setting \
. H Top: 1.27ecm  Bottom: 1.27 cm H
Print : E e e 1| choose Custom Margins to set your
.
.
E 5 Normal Own)
Pl’lﬂter g Top:  254cm  Bottom:2.534 cm
= = . Leftt  2.54ecm  Right 234 cm
a==. Microsoft Print to PDF .8 9. Pages per sheet
Ready I S Narrow
Printer Proger‘tls; Top:  1.27cm  Bottom:1.27 cm
| Left  1.27em Rightt 127cm
c . =
Settings :
4 Moderate
|TD Print All Pages | ) ] Top: 254 cm  Bottom:2.54 cm L
The whole thing 1{ Leftt  197em Right 191cm @ 1 Page Per Sheet }
G
Pages: i Wide
- . y .2 54
E Print One Sided Fi Ij I:"ﬁ. gz‘;z:: Eiogii'mlglig E:: D 1 Page Per Sheet
Only print on onesideoftl’i.
—  Collated ;-r Mirrored 2 Pages Per Sheet
FDE 123 123 123 : v Top: 254 cm Bottom:2.34 cm
- - - E Inside: 3.18cm  Outside:2.54 cm
[ i & HH 4 Pages Per Sheet
6 D Portrait Orientation - W
S’ & Custerm Margins...
o EIEE -
_7/ |:| Ad o | Narrow Margins 6 Pages Per Sheet
J 21 emx 29.7 cm o A Left 1.27cm  Right: 1.27... /{
» 4 0000 -
8 D Narrow Margins r 8 Pages Per Sheet
Left 1.27em  Right: 1.27.. oom
§ 16 Pages Per Sheet
R D

Page Setup

W(CA Created by: Julie Martin 25/06/2024
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10, e

Settings = o
T 0 .
e ] — = \ 11. You can access printer
~— Top  [1z7em |8 pottom 1z | properties from the link
Prirt One Sided 2 Left: 1.27 em S Right 1.27 am =
oy gt b it SEA Gutter: 0cm “s-  Gutter position: Left here
3] 1 . Orientation
D PomtOtenision - 12. The "Page Setup" link
. X rererr— 4 gives you some additional
1 Haron Mg W - : options, some of which are
=il e 127 0 Muttiple pages: Normal

=T 1 g S . mirrored in Layout and
v Preview Settings, such as Margins,

1

. Orientation, Size,
Headers/Footers, borders
etc.

3 Apply to: '\Vholt document
)
»

. . ——
. Set As Default % oK Cancel

& &

Margins lqout Margins  Paper E
&) S

S
f Section stagt: New page d N

Suppress endnot

~

width: 21 eom

Headers and footers

Height: 297 ¢m
(D) Different odd and even

Paper source =
First page: Other pages: _J Different first page
[Defautt tray Detaukt tray Header 125cm 5
From edge:
Footer 1.25om =
Page

Vertical alignment: Top

Preview Preview
Applyto: Whole document Print Options... %o: Whole document Line Numbers.... pvdew/
Set As Default | ox | Concel Set As Default ok | cancel
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Il. Excel 365 vs Excel desktop

Excel online:

Printer t v
5Ol ook @ @- = | ] st @ @
— My Bocal printer hd File ome nser Share P La
Hnme InSErl Share Pm i] Bring from pr ﬂ'.il’:l';lﬂ',-l‘ﬂ'.illﬁﬂ I H I ' h
(a Autosaved online to Documents ‘2a Eij:;——- L Ej It_i B
Page |Print Breaks Sheet
) New b Page setup Setup Prea~  ~ Right-to-Left
& ”FJ'?H 3 Print _,—2,, Phoe Setup Shest Options
o Share i iF Ach ches ¥ alternatively, go Page Layout > Page Setup
O Create a Copy > [ tgnore prin ares (method 2), and then after checking the
Paper size . . . 5
I+ Export 1 > ° D e—— _| basic options click on the Print button (2a)
6 Print ‘-—
Orientation note: If you need to return to the
() Rename D Poi “' workbook to make any changes (in
ES Maove Fie ’“E"“"-"“‘ method 2) click on "Back to workbook"
) Varsi Hi Marrow ~ .
O Version Hatory button on top left side
() Info b Scaling
== Options 3 ]D Custom scaling w P
‘f
. Scale Percentage 70 % : EE: F i 3 @ -
To print from Excel S
. . ~ Format options ;
365 online go to File i [ satoweneea™)
and C|IC|( on "priﬁt" D Rew and column headings
method 1 Bl
( ) . & TRy
enter on page
B Horizontally Home Insert Share | Page Layout
D Vertically

You can also access a "Print Area"
(3) option under Page Layout to
print a selection

W(CA Created by: Julie Martin 25/06/2024

Print Titles and

B

Page 5 of 11



i

Printer
Itg] My Bocal printer w I

Ig] 7) Bring thoen prinsers akeady installed

Print " on your device

Print

Eﬂ Active sheet e

E8 Active sheet

B Entire workbook

wlh
Page setup o £ | BB cCurrent selection
Print
l Paper size
BB Active shest Sy .
— A4 (B.2Tx11.697 R4
D Ignore print area “
r Orientation
Paper size ‘
7 D Portrait w
A4 (B2Tx11.607) 3
e [ Pertrait
Orientation I'I
L cape
D Portrait 4\1‘“ L Landzes
-
Page margins _J P
D MNarrow 5 v-! i
= |:| Marrow v
Scaling Mormal
r= ) Top: 7§ Bomtam: 075
I Custom scaling 6% - Lk 07 Right @7
Scale Percentage 70 % - f“"‘i :|:] Wide
Topc 1 Bottom: 1
-’ Lefe: 1 Right 1
~ Format options ‘L
G Marnow
[ cridiines 8 ‘\ Top Q75"  Bosmem: 076"
D Row and column headings e 2 e L= =
[ Brack snd white
Sealing
Center on page - |
C calin
B Honzontally 9 B Custom scaling s
D Vertically — Eﬂ No scaling
« Pages (Print total: 3) "‘I 0 T Fit sheet on one page
Pages s
Fit all colurmng on one page
Custom w~ -
Fit all rows on one page
ch -
003E pages
| 18 | [} Custom scaling
. Colour
Print ?
Total: 3 sheets of paper Colour w
Colour
Printer /]
™ Black and white
Micresoft Print to PDF v
Copies )
d ’f Fewer settings
! ,2, i' Paper size
[ f;
Layout I Al - v
[
o Portrait [
3 ] Scale (%)
Landscape -’ !
20 P "' O Fit to printable area
! 8
Pages [ Actual size et
s 4
(& Y
O a y o0
!
Odd pages only I
[ Pages per sheet 9
Even pages only ; —
I 1 R
e.g. 1-5, & ""I-'_I"I
J J oy 10
i/ 1?’
Colour Bi 4 g 300 dpi v
St et _,‘I E}
Celour - e i
','-' Print using system dislogue... (Ctrl+Shift=F)
-
More settings o7
-
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In this Print dialogue you can choose the
following options:

1. Printer (only My local printer and PDF
available)

2. Area to print (active sheet/entire
workbook/current selection)

3. Paper size (always ensure it's set to Ad)

4. Orientation (portrait/landscape)

5. Page margins

6. Scaling (none/fit sheet on 1 page/fit all
columns on 1 page/fit all rows on 1 page/custom)
7. Scale percentage

8. Format options (gridlines/row & column
headings/B&W)

9. Center on page (horizontally/vertically)

10. Pages to be printed (total pages shown here)
(all/custom) in the field "Choose pages" you can
type the page numbers you want to print -

2-  will print from page 2 to the last page

1-3  will print pages 1 through 3

1,2,4-6 will print pages 1,2,4,5,6

11. When ready click on the Print button

You will be taken to the final PRINT dialogue (see
below)

The options in the dialogue are:
1. Printer
2. Copies
3. Layout (Orientation)
4. Pages to print
5. Colour (this option shows only if PDF or a
printer able to print in colour is selected)
6. More settings link:

7. Paper size

8. Scale (%)

9. Pages per sheet

10. Quality (this option shows only if a
printer able to print in different quality
settings is selected)

11. Print using system dialogue

Note: the same dialogue is accessed by going
to File > Print

Page 6 of 11



Desktop Excel version:

Formulas Data Review View Help Q Tell me Before YOU print any file in Excel it is a
= good practice to check the following
L=

print | S Height |Automatic - 3 options to ensure the best fit for
ey firear v Titles ] Scale: 100%

SPage skl e, , = saewort = the data to be printed, in Page Layout

ﬁWidth: Automatic -

R check:
FTEE {E9T] =Ty
rgins Orientation  Size  Print  Breaks Back Drientation  Size © |t - Tite: | & "*;
coomsene B B § ey ] 1. Margins (pre-set or custom)

Last Custom Setting

10 % 15 om (4 x 6 i)

Top: 19em Bottorm: 1.9 cm : 10,96 cmx 1524 em H H H
lefe  06am  Rght 06em | Pt I — 2. Orientation (portrait/landscape)
148 cmx 21 om

Header: 0.8cm  Footer 0.8cm

) Londscope 3. Size (always ensure it's set to A4)

Normal

Top:  1.91cm Bottom:1.91 cm
Left:  1.78cm Right 1.78cm

2794 mm)

Logal (2150 % 3556 man
2158 cmx 3556 cm

1

You can also check these same

Header: 0.76 cm  Footer: 0.76 cm

Ewecuthve (1841 x 2667 mm)
Wide 141 cm x 3667 em

Top:  254cm  Bottorm:2.54 cm
Leftt  254cm Right 2.534cm

Header: 1.27 cm  Footer: 1.27 cm

A3 (297 x 420 mm)
ATcmx 4 om

Ledger (279.4 x 431.8 mm)
2799tk 4378 o

N s I

13 %18 cm (5 x Tl
1T ema 11T em

Narrow
— Top: 191 cm  Bottom: 1.91 cm 122i0.cm 1S x 8in)
Left: 0.64cm  Right: 0.64 cm 127 emx 0.3 em
— Header: 0.76 cm  Footer: 0.76 cm G 13 em (15 % 5 in)

B8 cmx 127 em

5 Emvedope (162 x 229 mm)
162cmx 228cm

Custorn Margins...

Com-10 {104.7 x 241.3 mm}

Print options:
1. Print button
2. Number of copies

Copiex |1 - 3. Printer
= 4. Sheets to be printed (active/entire
SR workbook/selection)
(“Printer femmemtesl 5. Print on one/both sides (this displays
— only if the chosen printer has it available)

Offline

Print Printer Properties

L y
— /Setﬁngs )

e 6. Collated (collated/uncollated)
| owpmmessesmersd 7 QOrientation (portrait/landscape)

Print on Both Sides

Fip g ooy adgs 8. Paper size (always ensure it's set to A4)
7 Print on Both Sides

Fip pages onshrt o 9. Margins (pre-set/custom)

Print Active Sheets

Export Only print the active sheets

Pages: .| to = g —
Publish ot o : .

[ Pint One sied o & eS| 10. Scaling (none/fit sheet/columns/rows
Close J Qf\lyipvint on one side of th...  — } :I:u::: & x:

on 1 page/custom)

Collated . EE— — - |
ecous 123 123 123 [ 7@ 2 mris| 11 Page setup link (other options)
— o 12. Navigate through pages

A4(210x297r:‘nq jL: H 25tcm Botom234cn

0
Options — 21cmx297cm %,

-
7 Last Custom Margmssgmng 1
2 , DXET O . ot
Left 0.6cm Right 0. oem t——t  Huader
.

No Scaling

Print sheets at their actual size

50

.

Custom Scaling ’.. PEIE LIE ARt

3 + Fit Sheet on One Page

"1;’ Shrink the printout so that it fits
on one page

‘1 ~1 Page Sct;.‘

Fit All Colurnns on One Page
“ﬁ Shnink the printout so that it is
one page wide

L3

Collated
123 123 123
Uncollated

111 222 333

Fit All Rows on One Page
1 Shrink the printout so that it is
one page high

Custom Scaling
12 Custom Scaling Options...

e
Lh_
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Page Setup ? * Page Setup

Header/Footer  Sheet Page Header/Footer  Sheet
Orlentation Top: Hegder:
© Fortrait O Landscape 19 k& 0.8
Sealing
© Adjustto: | 100 - % normal size Left: Right:
O Fit to: 1 + | page(s) wide by | 1 > tall 1.8 & 1.8 %
Paper size: A4 210 x 297 mm) e
Print guality: - Bottom: Foater:
) 19 |54 08 |
Figst page number: | Auto
Center on page
() Horigontalty
] Wertically
Erint... Print Preview Qptians... Print... Print Preview Options...

E Cancel : Cancel

In Page setup "Page" tab you can also (just like in main print dialogue and in Page Layout) set
orientation, scaling, paper size.

In "Margins" you can also set margins and Centre the file on page Horizontally or Vertically.

Page Setup ? X
Page Margins
Header ? X
| Header
Header: To format text: select the text, then choose the Format Text button,
{nane) Toinsert a page number, date, time, file path, filename, or tab name: paosition the
insertion point in the edit box, then choose the appropriate button,
Custom Headoer... Custom Footer... To insert picture: press the Insert Picture button, To format your picture, place the
= — cursor in the edit box and press the Format Picture button.
Eooter:
= = o = 2 | [ =
(nang) v Al BB @O B @] ko
Left section: Center section: Right section:
| a a a
G_Differ:n‘t odd and even pages
[ Different first page
B 5cale with document - - -
@ Align with page margins
oK Cancel

Frint... Frint Preview Options...

. .

In Page setup "Header/Footer" tab you can also (just like under Insert in the file) create a
custom header and footer, or select from dropdown menu, you can also choose different
settings for these, and format them but clicking on the respective button.

W(CA Created by: Julie Martin 25/06/2024 Page 8 of 11



Page Setup ?

Page Margins  Header/Footer @

Print grea: 1
Print titles
Bows to repeat at top: |

Columns to repeat at left:

(] Gridiines

o Comments: At end of sheet
;_J Black and f‘mm _3 Cell errors as:  displayed
(] Draft guality 4 - PSR ——
e £
j Row and column heh‘ng; 'o_‘ ——
»
Page order . —— 5 | 379
a Down, then over | o & 353
E 151
() Ower, then down = t . A
[3 318 Q 4 384
€ 202 Ezll 3 282
L3 338 »BE 887
L} - D!
= - : N L} 100 L] 50
Print... Print Preview Options... " 170 o 362
€ - #Diwio!
Cancel WS % - 130 a8 80
anberm € e, 315 55 485
¢ € 'h,. ®Dngo!
[3 2121a (311 4 326
€ 268 | *e, ms|f 315
3 219 “epalk 255
£ - 201w
€ 330 24 L85
L] 185 IR 348
L] i51 T € 16

Under "Page Layout" tab
you can also set:

H- &

Prnt giepks Backgrou
I o

File Data

=

Breaks Background

srmulas Review  View Q Tell mew

iy
s}
Print
Area -

PageSetup

Help

eennafg H?El?r;v E B¥ Iy
ﬂrqm'-"" "---[--I-J |

Themes Margins Orientation” "$ie"
. [@lefrects - : . -

os Width:  Automatic -

[ Height: |Automatic ~

1. Print area (set or clear) - you
have to select the area to be
printed first, then choose "Set

Clear Print Area

Themes Scale to Fit

On the "Sheet" tab there are
4 useful options:

1. You can select rows or
columns to be repeated on
every page (see next picture
for more detail)

2. Select comments to be
printed on a separate sheet
3. Select whether to display
errors when printing

4. Other options such as
gridlines, B&W, draft quality,
row and column headings

3. Automatic and custom scale to fit
(width/height/percentage)

You can choose Automatic for both
Width/Height or just one, and adjust

Print Area” and go to File and Print ‘1 i the other. Alternatively, adjust the
and you will see the selection in percentage for a better fit. This
the preview, you can also add to option is also available in Print
’ % % 2
the selection but it will be printed A4 - £ | PrintTitles and Headers & Footel e . '2 dlalogue. *
on a separate page. Note: don't A B < :::Mw'm Hmmm{"—_ = <
forget to clear print area before T <
doing any other printing (no need P :}
to select the area anymore) | P
5 Kelly Williains """ " | Cardl Adams “* | Rapid City D ridiines e [ »
6 |Kelly Williams Vicky Freymann Elmhurst [ Black and white ey [ -
7 |Cassandra Brandow| Neil Ducich Chesapeake [ Dratt quality - )
8 [Chuck Magee Chloris Kastensmidt  |Columbus [0 Row and cojumn headings
9 |Kelly Williams Shahid Collister El Paso Page ander
10 |Anna Andreadi Toby Swindell Scottsdale gg::"‘;:::::;
11 |Cassandra Brandow|Shirley Daniels Alexandria o
12 |Kelly Williams Guy Armstrong Columbia
13 |Chuck Magee Chloris Kastensmidt  |Columbus
14 | Chuck Magee Michael Moore Newark Print... Print Preview | = Options...
15 |Kelly Williams Shahid Collister El Paso
16 | Anna Andreadi Jason Fortune- Logan G Eaneel

2. Print Titles will open the Page Setup dialogue where under "Sheet" tab you can select rows or columns to be
repeated on every page. Put the cursor into the field and then select the whole row or column you want

repeated from the sheet. Click ok and check the preview.

W(CA Created by: Julie Martin 25/06/2024
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lll. PowerPoint 365 vs Powerpoint desktop

PowerPoint online:

l" Business Project Management Online Training Presentation @

File |Home Insert Draw Design Transtions  Amimations . . . N . .
. " To access the Print dialogue click on File then click on Print.

€@ Autossved online to Documents " .
) Choose from 3 options:
£ Mew >l
& Open ’ * Print full page slides
(% Share > * Print slides with notes
D crestea copy > * Print handouts
1=+ Export
C@ Print full page slides . . i i i
The file will be converted to a PDF, and a Print dialogue will open
@) Rename Cg Print slides with notes
By Move file Print handouts

R -
() Info >

Print 9 Here you can choose the following:

Total: 20 sheets of paper 1' Printer

. 2. Number of copies
1 olour 3. Layout (portrait/landscape)
- Microsoft Print to PDF ~ N

Colour v 4. Pages to be printed

Coples Colour 5. Colour (if printer has the option)
2 Black and white 6. More settings link:
| Layout F‘ * Paper Size (always ensure it's set to A4)
3 [ Portrait 'i Fewer settings * SCB'E ‘Fit tO' printable area/
- O Landscape £ 1| paper size Actual size/Percentage)

H N y * Quality (this option will only display if it's
ages ' = -
4 7 i available and depends on the chosen printer)
- | © A i Scale (%) "
i Pages per sheet
Ddd pages only " O Fit to printable area * . . .
f - Print using system dialogue
Even pages only ! ) Actual size -7
i
I 100 Print on both sides N . .
eg 1581113 § 7. Print on both sides (this
I Print on one side £ | . : . .
5 ca i Pages per sheet option will only display if
= aur i Print on one side el .
- i , . Print on only one side of the page it's available and depends
Print 60 both sides on the chosen printer)

6 More settings PE———T | Quality Flip on lang edge
- 300 dpi g Print on both sides

“ Cancel Flip on short edge

Print using system dialogue.., (Ctrl+Shift+FP)
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Print

Share

Optiors

\ O st Heaer & Footer_J

fﬁrimer \ ‘.

== Brother
-
"a Offfine »

J
Printer Propesties
.

Il_] Print entine presentation
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3. Printer
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Slides:
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.

== Print One Sided )
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Collated
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Color o
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= - Color -
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